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Commonly-Asked Questions
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Question: How do I download the presentation slides file?
Answer: From your WebEx session, select File > Transfer. From the File 
Transfer window, select the file and then select Download. Enter the site 
in which to save the file and select Save. 



Commonly-Asked Questions
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Question: How do I obtain the questions and answers asked 
during this session?
Answer: From the WebEx session, select File > Save As > Questions and 
Answers. Enter the  site in which to save the questions and answers and 
select Save. 



Access Audio
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Broadcast Audio Stream
(computer speakers)

Note: Audio stream includes “listen only” mode. If 
audio stream is not working, call the webcast toll 
free number.

Phone
 Webcast Toll Free Number: 

1-877-605-6482 
 Webcast Passcode:

1069682

Note: Phone lines have been muted for this call. You 
have been placed in a “listen only” mode for 
presentation purposes.



Ask Questions
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1. Select Q&A at the top of your 
screen.

2. Enter your question in the text box 
next to the Send button.

3. Select All Panelists from the Ask 
drop-down list, and select Send.

Note: Panelists will attempt to answer all questions during the 
webcast. Presentation slides and recording will be published.

1

3
2



Agenda

Ultimate Software, in its sole discretion, may video and/or record this conference or portions of it, including but not limited to, the Question and Answer 
sessions and play said videos and recordings at various times in the future. Any individuals attending or participating in this conference acknowledges this, and 
consents to the use in the future by Ultimate Software, at its sole discretion, of the video or recording of his or her attendance or participation and waives any 
rights or interest in any such future use.

This presentation and content are for Ultimate Software use only. No part of this presentation or content may be reproduced in any form or by any means or 
stored in a database or retrieval system without the prior written authorization of The Ultimate Software Group, Inc. Information in this presentation and 
content are subject to change without notice. The presentation and content are confidential information of The Ultimate Software Group, Inc. and may not be 
disseminated to any third party. Nothing herein constitutes legal advice, tax advice or any other advice.

© 2016 The Ultimate Software Group, Inc. UltiPro® is a registered trademark of The Ultimate Software Group, Inc.
All other company and product names referenced herein are the trademarks or registered trademarks of their respective holders.

Liability/Disclaimer
The Ultimate Software Group, Inc. makes no representation or warranties with respect to the accuracy or completeness of the presentation or content and 
specifically disclaims any responsibility or representation for other vendor’s software. The terms and conditions of the license, Intersourcing, SaaS, or other 
agreement regarding the software or services provided by Ultimate Software, which is the subject of the documentation contained herein, govern this 
presentation or content. All company, organization, person, and event references are fictional. Any resemblance to actual companies, organizations, persons, 
and events is entirely coincidental. Nothing herein should be considered legal or tax advice. All legal or tax questions or concerns should be directed to your 
legal counsel or tax consultant. 

6

 Payroll Processing
 Tax Compliance
 Time Management



Payroll Processing

7



Payroll Processing
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 Reset Pay Groups
 Rest & Recovery Rate Feature
 Pay Statement Enhancements



Reset Pay Groups
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Reset your pay groups 
Menu > Administration > Payroll Admin > Payroll Utilities > Pay Group Reset



Reset Pay Groups
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 Each payroll automatically resets the monthly, quarterly, 
and yearly dates
 If pay group is no longer used, pay group may need to be 

reset manually
– If pay group needs to be reset, a message appears



Reset Pay Groups
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 Reset a pay group manually when:
– Pay group has not been processed in two months
– Employees were paid with this pay group during the current year
– Pay group is active with scheduled payrolls



Reset Pay Groups
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Reset a Pay Group
Menu > Administration > Payroll Admin > Payroll Utilities > Pay Group Reset

1. From the Pay group Reset page, select the month from the Month 
to Reset drop-down list.

2. Select each pay group needed.



Reset Pay Groups
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3. Select Reset. A message appears.
4. Select Reset. An informational message appears, notifying you of 

how many pay groups were reset successfully. 



Reset Pay Groups
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Review pay groups and tax groups from the Tax Group 
Information page
Menu > Administration > Payroll Admin > Payroll Utilities > Pay Group Reset > Things I Can Do > Tax Group 
Information



Reset Pay Groups
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 If the pay group is not available to reset, review the 
message column
– Messages alerts you to resolve issues ahead of time
– Messages indicate the tax group to which the pay group is assigned

Note: In some circumstances, you may need to inactivate unused payrolls for the pay group you are 
resetting.



Feature Benefits
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 Enables you to maintain dates of unused payrolls
 Enables you to resolve out-of-date pay groups directly 

from UltiPro
 Provides messages before you Reset, enabling you to 

resolve issues ahead of time



Rest & Recovery Rate Feature
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 California AB 1513 legislation was passed 
– Requires employees to be compensated for rest and recovery 

periods
– Relates to employees compensated on a piece-rate basis 
 UltiPro provides Rest & Recovery feature
 Rest & Recovery feature calculates the higher of:

– Federal minimum wage
– State minimum wage 
– Local minimum wage, if configured
– Average calculated value



Rest & Recovery Rate Feature
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 Modify your existing earnings to be included in Rest & 
Recovery calculation
– Select Rest & Recovery Wages
– Select Rest & Recovery Hours 



Rest & Recovery Rate Feature
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 Add new earnings to pay out Rest & Recovery time
– In Pay Rate for Payout section, select Piece Rate Rest & Recovery



Rest & Recovery Rate Feature
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 Rest & Recovery rate example for California employee
– Federal minimum wage: $7.25
– State minimum wage: $10.00
– Local minimum wage: $12.55
– Average calculated value: $10.00



Rest & Recovery Rate Feature
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 Assign local minimum wage to your locations
– Select the jurisdiction from the Local Minimum Wage Jurisdiction 



Feature Benefits
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 Calculates the average pay rate automatically
 Compares minimum wage limits and automatically uses 

the highest pay rate



Pay Statement Enhancements
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 Pay statement language
 Earnings print sequence 
 Shift and overtime display options

– Detailed Shifts
– Detailed Shifts and Overtime Rate of Pay
 Total Hours Worked 



Pay Statement Language
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Define Your Pay Statement Language
Menu > Myself > Personal > Private Info

1. From the Private Info page, select Edit.
2. Select the Preferred Language for Online Pay Statement.
3. Select Save.



Pay Statement Language
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 Languages are populated from your Display Settings
Menu > System Configuration > System Settings > Display

– Languages are selected from the Selected Languages section 



Pay Statement Language
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 Language option is available on the Pay Statement
Menu > Myself > Pay > Current Pay Statement

– Switch between preferred language and default English (USA)



Earnings Print Sequence 
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 Earnings Print Sequence is available for pay statements
– Available for printed and online pay statements
 Earnings are arranged according to priority

– Enter a value 1–9999



Earnings Print Sequence 
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Define the Print Sequence from Earnings Setup work event
Menu > System Configuration > Business Rule > Earnings



Earnings Print Sequence 
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 Manage display from Earnings Configuration page
Menu > Administration > Payroll Admin > Pay Statement Options > Earnings Configuration

– Update Description and Stub Description easily
– Update Display Sequence for pay data entry 
– Update Print Sequence for employee’s pay statements
 Sort columns to order earnings according to sequence



Shift and Overtime Print Options

30

 New pay statement display options are available
 Pay statement display options present shifts and overtime 

earnings in an easy-to-read format
 Three options available:

– Check Format Options*
– Detail Shifts
– Detail Shifts and Overtime Rate of Pay

*Note: The Check Format Options is a default option to preserve current functionality. 



Shift and Overtime Print Options
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 Assign Shift/OT Settings from the Pay Group Options page
Menu > Administration > Payroll Admin > Pay Statement Options

 Assign Shift/OT Settings according to pay group and 
check type
– Payroll check type includes Regular and Additional checks
– Instant check type only includes Instant checks



Shift and Overtime Print Options
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 Detail Shifts 
– Organizes each shift under the earnings
– Provides pay rate, hours, and current amount for each shift
– Provides year-to-date (YTD) column for each earnings



Shift and Overtime Print Options
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 Detail Shifts and OT Rate of Pay 
– Organizes each shift under the earnings
– Organizes each overtime according to the shift



Shift and Overtime Print Options
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 Assign the shift used for each earnings in paydata entry
– Coefficient overtime earnings is assigned with the corresponding shift
– Shift differential does not need to be flagged to assign the 

coefficient overtime to the corresponding shift



Shift and Overtime Print Options
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 Pay statement display enhancements
– Reduces regular hours with shifts matching coefficient overtime
– Displays coefficient overtime pay rate as combined time and a half 

pay rate (or other rate)



Feature Benefits
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 Improves pay statement to help better understand wages 
 Provides more detail on shift and overtime earnings
 Display coefficient overtime pay rate as a combined

pay rate



Total Hours Worked
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 Total Hours Worked field available for pay statements
– Provides the actual hours employees worked during the pay period
– Excludes hours for time that employees did not work
– Appears next to Total Hours value on the pay statement



Total Hours Worked

38

Configure Total Hours Worked for Pay Statements
Menu > System Configuration > Business Rules > Earnings 

1. From the Earnings business rule, select the earnings to include in Total 
Hours Worked.

2. From the Details step, check the Total Hours Worked box.
3. Select Next and Save.



Total Hours Worked
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Configure Total Hours Worked for Pay Statements
UltiPro backoffice > Setup Tables > Banks

1. From the Banks setup table, select the bank.
2. From the Checks tab, check the Total Hours Worked box to display 

this field on employees' checks.
3. Select Save.



Feature Benefits
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 Clarifies the pay statements hours
 Provides the actual time that an employee works



Tax Compliance
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Tax Compliance
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 Enhanced Wage Attachment Gateway
 Enhanced Form W-4 Completion



Enhanced Wage Attachment Gateway
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 New filter and sort options
– Deduction start date
– Deduction stop date



Enhanced Wage Attachment Gateway
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 Date fields defined on the garnishment configuration
– Deduction start date is required
– Deduction stop date is not required



Enhanced Wage Attachment Gateway

45

 Filter garnishments three ways:
– Enter a date in the From field
– Enter a date in the To field
– Enter dates in both fields
 Sort using the Deduction Stop Date column

– Review deductions without a stop date by sorting Stop Date column



Enhanced Form W-4 Completion
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Enhanced Employee Withholding Forms (W-4) experience



Enhanced Form W-4 Completion

47

 All withholding forms are provided for federal and state 
jurisdictions
– Provides easy form completion experience, compliant with current 

regulation forms
 E-mail notification available for expiring exemption status
 UltiPro messages appear, instructing employees to 

update withholding forms when employees:
– Add dependents 
– Change marital status



Enhanced Form W-4 Completion
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 Withholding forms are provided in questionnaire format
– Provides guidance when selecting options
– Provides instant validation of information
– Streamlines acknowledgment statement and is electronically signed
– Provides direct link to the full form
– Provides personal data and elections populated in the form



Enhanced Form W-4 Completion
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 Enhanced administrative processes for Form W-4
– Display or hide forms
– Configure exemption expiration email notification and reset of 

withholding elections
– Regulate max allowances per state and employer form requirements
– Upload paper forms



Feature Benefits
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 Streamlines administrative process
 Provides configuration options
 Simplifies employee experience
 Maintains form updates from new legislation
 Eliminates browser compatibility issues



Upcoming Webcasts
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 Enhanced Form W-4 Completion and Employer 
Management
– Date: 10/26/16
– Time: 1:00pm – 2:00pm Est

https://ultimate.webex.com/ultimate/onstage/g.php?MTID=e91ce39
41d53c22fb6e8da73f9ab067ee

 Enhanced Form W-4 Completion and Employer 
Management
– Date: 10/26/16
– Time: 3:00pm – 4:00pm Est

https://ultimate.webex.com/ultimate/onstage/g.php?MTID=e94dc0
6e32d61b4d4826ad2b91f394330

https://ultimate.webex.com/ultimate/onstage/g.php?MTID=e91ce3941d53c22fb6e8da73f9ab067ee
https://ultimate.webex.com/ultimate/onstage/g.php?MTID=e94dc06e32d61b4d4826ad2b91f394330


Time Management
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Time Management
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 Navigation Changes
 Timesheet Enhancements
 Pay Rate Synchronization
 Smart Recalc
 Multi-Lingual Capability



Navigation Changes
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 New Navigation for Time Management 
– Launches within UltiPro
– Uses the new navigation framework, colors, and fonts
– Contains a Pop Out option for administrators to open application in 

a new browser or window, if desired



Navigation Changes
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Employee timesheet displays in UltiPro



Navigation Changes
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Employee timesheet displays in “Pop Out” window



Navigation Changes
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 Supervisor View of Summary Page
– Before

– Now



Timesheet Enhancements
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 Employee View of Timesheet
– Before



Timesheet Enhancements
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 Employee View of Timesheet
– Now



Timesheet Enhancements
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Supervisor View of Employee Timesheet



Timesheet Enhancements
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Supervisor View of Employee Timesheet Detail Section



Timesheet Enhancements

62

 User Name Preference
 Timesheet Status Change Option
 New Time-off Alert Link (Detail and Hourly Timesheets)
 Columns Button on Detail Timesheet
 Notes Pop-Up on Detail Timesheet
 Recalculate Button Removed



User Name Preference
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Timesheet Audit Trail can show User Name instead of User ID
Attendance > Timesheets > Magnifying Glass icon in Audit column



User Name Preference
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 Select User Name on the Preference page
Users Setup > Preference

 Select magnifying glass icon to display audit report
Attendance > Timesheet or Summary



Timesheet Status Change Option
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 Note the Status Change option applies to both hourly and 
detail timesheets
 Select Status and change it to any level below the current 

status



New Time-Off Alert Link
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 Available from both hourly and detail timesheets
 Applies to pending requests during a pay period
 Enables supervisors to select the link and go to Manage 

Time-Off Requests page (Scheduler > Requests)
 Displays only those requests for the selected employee 

and pay period



New Time-Off Alert Link
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Manage Time-Off Requests page shows the pending time-
off request



Columns Button on Detail Timesheet
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 New Columns button available to all users
 Users can select and reorder timesheet columns

Note: With the addition of the Columns button, the column picker to the far right (    ) has been removed 
along with the Freeze Timesheet Display option in the Timesheet Column Setup section.



Notes Pop-Up on Detail Timesheet
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 Pop-up window appears when a note is added to  
timesheet row
 Note can be viewed and then closed without saving 

timesheet



Recalculate Button Removed
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 Before

 Now



Feature Benefits
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 Improves readability and ease of use of the timesheets
 Groups actions together
 Enables you to easily change the timesheet status
 Provides supervisors with the ability to quickly manage an 

employee’s time-off requests
 Improves speed of entry for hourly timesheet users



Pay Rate Synchronization
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 Employee base pay rate is imported via integration
– Information populates in Labor Costing reports and displays on the 

timesheet in the summary
– Current rate and prior rate are brought into timesheet
– UltiPro effective date is used
 Minimum wage tables also imported via integration

– Tables support new compliance rules that require minimum wage for 
validation and payment of violations

Note: These changes were included with the Time Management Monthly Release on September 15, 2016.



Pay Rate Synchronization
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Example of Detail Report.LC
Reports > Report Generator > Labor Costing > Detail Report.LC



Pay Rate Synchronization
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Feature is enabled through UltiPro
System Configuration > Time Management Setup > Integration Configuration > Import Employee Pay Rate 
option



Feature Benefits
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 Displays pay rate information in reports and on the 
timesheets
 Supports new compliance rules



Smart Recalc
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 Smart Recalc ensures that events are labeled correctly
 Smart Recalc contains two parts:

– Self-healing task status changes to Completed if task is in either 
Running or Started status and has last run completed time stamp 
and 100 percent progress
 Task fails if a task of the same type is run

– RECALC_UNCALCED_TS_JOB only runs on timesheets that are less 
than 30 days

Note: These changes were included with the Time Management Monthly Release on July 12, 2016.



Feature Benefits
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Prevents customer-scheduled events from displaying as 
“Removed” or “Failed”



Multi-Lingual Capability
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 Time Management delivers all standard reports and 
mobile experiences in UltiPro in Canadian French
 All pages, data in tables, icons, and buttons are 

translated to user's preferred language
 Multiple entries of descriptions (for example, pay codes, 

policies, and rules) are allowed for users to view 
information in UltiPro selected language preference

Note: These changes were included with the Time Management Monthly Release on June 14, 2016.



Multi-Lingual Capability
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Change Language Preferences
1. From the Home page, select Preferences.
2. From the Preferences page, select Edit.
3. From the Language drop-down list, select the preferred language.
4. Select Save.

Note: These changes were included with the Time Management Monthly Release on June 14, 2016.



Multi-Lingual Capability
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Time Management displays in French

Note: These changes were included with the Time Management Monthly Release on June 14, 2016.



Feature Benefits
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 Provides Time Management pages in a user’s preferred 
language
 Opens the possibility of delivery in other supported 

languages



Learning Resources
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Title Description Resource 
Type

New or
Update

Manage Supervisor Delegations Provides procedural information for 
supervisors on how to delegate access 
to your employees, be a delegate, 
and change delegate view options.

QuickTips Update

Create and Assign Points in the Point 
System Module

Provides instructions for creating, 
calculating, and assigning points in the 
Point System Module.

QuickTips New

Configure Accrual Rules in Time 
Management

Provides instructions for defining 
employee benefit accrual rule 
calculations.

QuickTips New

Configure Overtime Banking for 
Accruals

Provides instructions for employers 
outside the United States to apply 
bank hours toward work hours or non-
working hours.

QuickTips New

Enable UltiPro Time Management 
Mobile Features

Provides configuration instructions and 
troubleshooting tips for the Time 
Management mobile features.

QuickTips New



Time and Attendance
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Time and Attendance
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New Multi-View Scheduler



Multi-View Scheduler
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 Multi-View Scheduler enables you to:
– Establish and manage shift coverage requirements
– View time off that is entered via the Time Off Planner
– Use the Team structure for approval flows



Multi-View Scheduler 
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 Manage skills for shifts
– View job and skill-based qualifications for shifts
– Manage skill and credential expiration dates
 Define and manage workload requirements
 Use staffing requirements to determine shifts, jobs, and 

skills needed in a given period
 Establish long-term and short-term schedule rotations



Multi-View Scheduler 
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 View key performance indicators
– Filled and unfilled shifts and hours
– Total hours and cost
 View total coverage (scheduled versus required shifts)
 Swap shifts between employees
 Modify schedules via mass edits
 Manage schedule compliance via alerts and reports



Upcoming Webcasts
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 Time and Attendance: Multi-View Scheduler 
– Date: November 16, 2016
– Time: 11: 00 a.m. or 2:00 p.m. Est

Note: Newswire communication for registration to follow soon. 



Connections 
Hands-On 
Learning Sessions
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Connections 2017 takes place from March 
21-24, 2017 at the Bellagio in Las Vegas. The 
conference will include an amazing roster of 
speakers, breakout sessions, entertainers, and 
UltiPro® training.

Get the most out of Connections 2017 by 
attending UltiPro Hands-on Learning Sessions 
in one of our 4 special-interest topic areas.

Session Details:
• 12 courses are available in the following 

topic areas:
• Payroll 
• Reporting & Analysis
• System Configuration
• Compensation Management 

• 2.5 hours to 3 hours in length
• Sessions offered each day on Tuesday, 

Wednesday, and Thursday 



1. Register Now for Connections 2017
– Go to ultimatesoftware.com > Events > Connections Conference   

OR  ultimatesoftware.com/connections

2. Specific course topics announced in November

3. Course schedules shared in January 2017 

4. Session registration will be available in 
February 2017 to reserve a seat in your favorite 
session topic.  

5. See you there!

Registering for Hands-On Learning Sessions



Thanks … 

… for participating in today’s webcast!
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Commonly-Asked Questions
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Question: How do I download the presentation slides file?
Answer: From your WebEx session, select File > Transfer. From the File 
Transfer window, select the file and then select Download. Enter the site 
in which to save the file and select Save. 
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